
Appendice 
La Computational Fluid Dynamics (CFD) è una tecnologia di simulazione che consente di 
analizzare il comportamento di fluidi e gas in una vasta gamma di applicazioni. 

Uno dei principali vantaggi della CFD rispetto ai metodi tradizionali è che consente di eseguire 
analisi accurate e dettagliate in modo relativamente rapido ed economico. 

Per ottenere risultati affidabili tramite la CFD, è necessario seguire un processo ben definito 
che comprende tre fasi principali: la creazione della geometria del sistema e del dominio di 
calcolo, la creazione del mesh e il settaggio del software di simulazione. 

La creazione della geometria del sistema e del dominio di calcolo rappresenta il primo 
passaggio fondamentale per eseguire una simulazione CFD. La geometria del sistema verrà 
creata utilizzando il Workbech di Ansys e in questo paragrafo verranno mostrati i procedimenti 
nella creazione della geometria e del dominio di calcolo. 

La creazione della mesh rappresenta il secondo passaggio chiave nella simulazione CFD. La 
mesh è una griglia di elementi che suddivide la geometria del sistema in parti più piccole, 
consentendo così di calcolare il comportamento del fluido in modo discreto. La creazione della 
mesh è un processo complesso che richiede una buona conoscenza delle tecniche di meshing 
e una valutazione accurata del trade-off tra la precisione della simulazione e la complessità 
computazionale. 

Infine, il settaggio del software di simulazione rappresenta il terzo passaggio fondamentale. Per 
eseguire la simulazione, è necessario selezionare il software di simulazione più appropriato per 
il problema in esame e impostare i parametri di simulazione corretti. In particolare, il settaggio 
del software di simulazione richiede una comprensione approfondita della fisica del problema, 
delle condizioni al contorno e dei modelli di turbolenza. In questa sezione, fornirò una guida 
dettagliata su ciascuno di questi passaggi, descrivendo le tecniche e le procedure necessarie 
per creare una geometria accurata, generare un mesh di alta qualità e impostare correttamente 
il software di simulazione Ansys Fluent. 

Geometria e dominio di calcolo 

In questo lavoro di tesi, il profilo considerato è quello di un ugello TIC del quale si hanno già a 
disposizione le coordinate dei punti che definiranno il contorno.  

Per andare a creare un file ‘.step’ all’interno del quale sia presente il contorno del dominio di 
calcolo è stato utilizzato il software Gmsh.  

Si consiglia di fare attenzione all’uso di parentesi e comandi nei vari file di testo per una 
corretta implementazione su Gmsh e una corretta creazione del file ‘.step’.  

Le coordinate dei punti sono state salvate nel file ‘punti_geometria.txt’, facilmente 
modificabile e leggibile attraverso diversi editor di testo come ‘WordPAd’ o ‘Blocco note’.  



Il progetto sarà 2D, per cui la corretta definizione dei punti (coordinata z posta uguale a 0) sarà 
del tipo:  

• Point(n) = { xn, yn, 0}; 

 

 

Una volta definiti i punti del contorno dell’ugello, si può aprire il file ‘geometria.txt’ che sarà il 
file da implementare in Gmsh per la creazione del file ‘.step’.  

Si consiglia di copiare le prime due righe esattamente come sono scritte. Si tratta 
essenzialmente di comandi base per implementare il tutto in Gmsh e Ansys.  

Il file dovrà quindi iniziare con:  

• SetFactory("OpenCASCADE"); 
• Mesh.MshFileVersion=2.2; 

Si possono quindi includere i punti e i comandi presenti all’interno del file ‘geometria.txt’, con 
il comando Include.  

Verrà quindi scritto:  

• Include "punti_geometria.txt"; 



viene utilizzato il comando BSpline come in figura per poter interpolare i punti assegnati dal 
file "punti_geometria.txt"; 

 

Infine, vengono definiti i punti che caratterizzano il campo esterno e le linee mancanti al fine 
di creare un contorno CHIUSO tra tutti i punti. Nel caso in cui il contorno fosse aperto (e 
quindi non siano state definite correttamente le linee tra i vari punti, Gmsh segnalerà l 
‘errore).  

IMPORTANTE: per una corretta implementazione su Gmsh, tutte le linee e punti devono avere 
il proprio indice. Non potrò quindi andare a definire due linee con indice uguale. (Es:  
BSpline(1) e Line (1) NON si può scrivere perché il software vede che ci sono due linee con 
indice 1).  

Viene creato un ‘Line Loop’ che definisce l’orientamento delle linee e il comando Plane 
Surface va a suggerire a Gmsh che all’interno di quel contorno è presente una superficie.  

 

Una volta definito il file, si può aprire Gmsh. 

Nel menù a tendina si segue il percorso:  

• File – Open – scelta del file ‘geometria.txt’;  

Se tutto fosse corretto non dovrebbero presentarsi messaggi di errore.  



 

A questo punto si può procedere con la creazione del file ‘.step’.  

Si segue il percorso:  

• File – Export – selezionare l’estensione ‘.step’ e salvare. Per alcune versioni di Gmsh 
occorre inserire manualmente l’estensione “.step” alla fine del nome del file.  

 

A questo punto si è pronti per l’implementazione su Ansys.  



Ovviamente gli stessi procedimenti verranno svolti per il dominio contente anche il campo 
esterno, definendo nel file ‘.txt’ le linee e i punti aggiuntivi e definendo correttamente il Line 
Loop.  

 

 

Arrivati a questo punto si può aprire Ansys Workbench.  

Si segue il percorso:  

• Menù a tendina: Fluid Flow (Fluent) -> tasto sinistro del mouse su ‘Geomtry’ (NO 
doppio clic) -> tasto destroy del mouse su ‘Geomtry’ -> ‘New Designer Modeler’.  

 



Una volta aperto il Designer Modeler si segue il percorso:  

• File -> Import External Geometry File-> scelta del file ‘.step’ precedentemente creato -> 
Import -> Generate 

 

 

 

In questo modo si vedrà apparire il nostro dominio di calcolo.  

Bisogna ricordare che Ansys lavora con le corrette unità di misura; quindi, a seconda di come 
si sono definite le coordinate dei punti è possibile che il dominio debba essere 
opportunamente riscalato.  

Nel nostro caso si vede come il dominio debba essere riscalato di un fattore 10 per cui si 
esegue:  

• Create-> Body Trasformation -> Scale -> nella finestra ‘Modelling’ cliccare su ‘Bodies’ e 
selezionare con un clic il dominio di calcolo -> definire il fattore di scala -> Generate 



 

 

Dopo aver creato la geometria, selezionare dal menù in alto a sinistra la voce  

• Concept → Surfaces From Edges 

 selezionare tutte I bordi e cliccare ‘Apply’ -> Generate 

 



 

Dopo aver seguito correttamente tutti i passaggi, verrà creata una superficie che sarà il 
dominio di calcolo. Successivamente, prima di procedere con la mesh, è opportuno 
suddividere il dominio di calcolo in modo tale che successivamente Ansys riesca a creare una 
mesh regolare senza zone di distorsione.  

Per fare ciò, bisogna andare sulla voce ‘Sketching’ presente nel menù laterale.  

 

Si procede con la suddivisione del dominio di calcolo mediante le linee. Selezionare dunque 
la voce Line e tracciare il numero di linee che si ritiene opportuno per una suddivisione della 
mesh ottimale.  

Si consiglia prima di tracciare le linee sulla superficie creata, e successivamente di andare a 
posizionarle correttamente. Le linee orizzontali saranno contrassegnate dal simbolo H le linee 
verticali saranno contrassegnate dal simbolo V. 



 

Dopo aver creato le linee di suddivisione, si procede selezionando la voce ‘Dimensions’ dal 
menù laterale e selezionare la voce Horizontal per andare a posizionare correttamente le 
linee verticali e la voce Vertical per posizionare le linee orizzontali Una volta selezionato la 
linea d’interesse, indicare la distanza della linea dall’asse delle Y nel menù in basso a sinistra. 

È consigliabile inserire le distanze utilizzate per la creazione del dominio di calcolo. 

 

Una volta posizionate correttamente le linee, selezionare il percorso: 

• Concept -> Lines From Sketches -> selezionare tutte le linee create e cliccare sul 
pulsante Apply nel menù laterale -> Generate 



 

Una volta create le linee, selezionare la voce dal menù in alto a sinistra  

• Tools -> Projection  

 

In questo modo si andrà a proiettare le linee appena create sulla superficie del dominio di 
calcolo. Così facendo creeremo una suddivisione del dominio di calcolo per poi andare a 
creare una mesh regolare. 

Successivamente selezionare tutte le linee che si vogliono proiettare sul dominio di calcolo e 
successivamente selezionare la voce Apply nel menù laterale come mostrato in figura. 



 

Successivamente, selezionare la voce ‘Target’ dal menù laterale a sinistra e selezionare la 
superficie sulla quale si vuole proiettare le linee. Dopo aver selezionato la superficie cliccare 
Apply. 

 

A questo punto, dopo aver eseguito correttamente i passaggi, il dominio di calcolo sarà 
suddiviso in più parti. Prima di procedere con la mesh, selezionare la voce: 

• Line body → Suppress Body 

 

Come ultimo passaggio, dal menù laterale, selezionare la voce ‘Surface Body’ e 
successivamente la voce:  

• Fluid/Solid → Fluid 



 

Si consiglia di salvare il file prima di uscire da DesignModeler. 

 

 

 

Generazione della mesh 

In questo paragrafo verrà mostrato il procedimento per la generazione di una mesh regolare ai 
fini di calcolare il comportamento del fluido in modo discreto. Dalla schermata principale di 
Ansys Workbench, selezionare la seconda voce Mesh. 

 

Una volta aperta la voce Mesh, all’interno della schermata, selezionare con il tasto destro la 
voce Mesh nel menù laterale e successivamente:  

• Mesh -> Insert -> Face meshing 



 

Successivamente selezionare tutte le superfici che compongono il dominio di calcolo e 
selezionare dal menù laterale la voce: 

• Geometry ->Apply -> Generate 

 

Si ottiene la seguente mesh che, come si può notare, mantiene la proprietà di non avere celle 
sfalsate (se si guardano diverse zone del dominio, si vede che le celle di interfaccia 
mantengono la continuità della griglia).  



 

La mesh così creata è una mesh di tipo strutturale ma essa non è ancora adatta alle 
simulazioni CFD. Per questo motivo, bisogna ridurre opportunamente gli elementi che 
compongono la mesh. Nelle zone di maggiore interesse, come lo strato limite e l’uscita del 
Nozzle, è opportuno rendere la mesh più fitta. Nelle zone di minor interesse, come il Farfield, 
si potrebbe rendere la mesh meno fitta così da avere un guadagno in termini computazionali. 
Per infittire la mesh, seguire il percorso:  

• Tasto destro ‘Mesh’-> Insert -> Sizing 

 



Una volta selezionata la voce Sizing, il programma ci permette di dimensionare gli elementi in 
diversi modi. Il metodo di Sizing utilizzato in questa tesi è il dimensionamento dei bordi. 
Dunque: 

• Selezionare l’icona Edge; 
• Selezionare i bordi d’interesse; 
• Selezionare la voce sul menù laterale Geometry → Apply 

 

Una volta aver selezionato i bordi, dal menù laterale selezionare la voce: 

• Type → Number of Divisions; 
• Number of Divisions → inserire il numero di suddivisioni; 
• Behavior → Hard 

 



Ripetere i seguenti passaggi per tutti i bordi inserendo il numero di divisioni che si ritiene più 
opportuno. Una volta eseguiti i seguenti passaggi, selezionare il pulsante Generate e si otterrà 
una suddivisione della mesh come mostrato in figura.  

 

Si tratta di una mesh strutturata dove la mesh dell’ugello risulta essere molto più fitta rispetto 
alla mesh della zona Farfield. Questo perché la zona interna all’ugello è una zona di maggior 
interesse dove vi si sviluppano onde d’urto e separazione del flusso. Da notare come però 
questo tipo di mesh è adatta solo per simulazioni Euleriane, ovvero simulazioni inviscide non 
vi è la presenza dello strato limite. Per ottenere una mesh adatta anche per le simulazioni 
viscide (si ricorda la richiesta di y+ per poter valutare il sottostrato viscoso in diversi modelli di 
turbolenza), c’è bisogno di creare un infittimento della mesh vicino alla parete dell’ugello. Per 
fare ciò, selezionare nel menù laterale la sezione: 

• Edge Sizing -> Bias Factor 

 In questa sezione si aprirà un menù a tendina dove sarà possibile andare a selezionare il tipo 
di infittimento desiderato. L’esempio della Figura XXXI mostra un tipo di infittimento più 
spesso sull’asse di simmetria e gli elementi diventano sempre più fitti a parete. Selezionato il 
tipo di infittimento, inserire anche la voce Bias Factor (Figura XXXI), che indica il rapporto di 
lunghezza tra l’elemento più piccolo e l’elemento più grande. Esempio, se Bias Factor=200, 
l’elemento più piccolo avrà una lunghezza 200 volte più piccola rispetto all’elemento più 
grande (sempre come riferimento il bordo selezionato) questo procedimento viene mostrato 
nella seguente. 

Nel caso in cui fosse necessario, in fondo al menù laterale si può selezionare su quale bordo 
invertire la direzione di infittimento (Reverse Bias).  



 

Selezionando la voce Generate si andrà a generare la mesh come mostrato nella seguente 
Figura.  

 

Notiamo come si è creata una mesh più fitta sulla parete dell’ugello e meno fitta sull’asse di 
simmetria. Questo procedimento deve essere ripetuto anche sugli altri bordi del dominio 
computazionale fino ad ottenere una mesh come mostrato nella figura sottostante.  

(I valori del Bias Factor non sono definiti a priori ma possono variare in base allo studio che si 
sta affrontando).  



 

Dalla figura notiamo come la mesh sia più fitta sulla parete dell’ugello e sulla sezione d’uscita 
dell’ugello. Mentre, è meno fitta sul Farfield. 

Come ultimo passaggio, andiamo inserire le condizioni al contorno sul dominio di calcolo. Per 
definire le condizioni al contorno, seguire il percorso:  

• Tasto destro sul bordo del dominio di calcolo che si vuole rinominare -> Create Named 
Selection 

In questo modo l’utente potrà assegnare a ogni bordo del dominio il giusto riferimento fisico.  

Le condizioni al contorno selezionate per il tipo di analisi eseguite in questo elaborato di tesi 
sono:  

• Inlet  
• Outlet  
• Symmetry  
• Farfield  
• Wall 

Il software Ansys Fluent riconosce in automatico le condizioni al contorno che sono state 
selezionate. Da precisare che è stata inserita una prima condizione al contorno “Wall 1” che 
fa riferimento alla parete dell’ugello principale e secondario, mentre una condizione “Wall 2” 
che in prima battuta  verrà considerata come parete solida, mentre diventerà un “Pressure 
Inlet” nelle analisi in cui si vuole simulare la presenza di un getto secondario.  



 

 

 



 

 

 

Come ultimo passaggio importante, sul menù laterale selezionare sulla voce  

• Geometry → Surface Body  

Assicurarsi che sul menù laterale sia selezionata la voce  

• Fluid/Solid → Fluid 



 

A questo punto salvare il progetto appena eseguito ed uscire dalla mesh e aprire la finestra 
Workbench. Una volta aperta la finestra, selezionare con il tasto destro su “Mesh” e 
successivamente selezionare la voce “Update” per aggiornare le modifiche appena eseguite. 

 

 

Settaggio Parametri di Calcolo su Fluent 

In questo paragrafo verrà mostrato il procedimento utilizzato nel settaggio dei parametri di 
calcolo su Fluent. Dalla schermata principale del Workbench selezionare due volte con il 
pulsante sinistro la voce Setup per aprire Fluent. 

Successivamente si aprirà Fluent Launcher dove l’utente può scegliere, in base alle proprie 
preferenze di calcolo, il tipo di opzione e processi di solving. 

Una volta impostato il settaggio, selezionare la voce “Start” e si aprirà la schermata di Fluent. 



 

Nella sezione General, viene impostata una simulazione “Density-Based” e una simulazione 
2D “Axialsymmetric”. 

 



Quando si imposta il tipo di simulazione Axialsymmetric, Fluent potrebbe dare un messaggio 
d’errore dove viene indicato che la zona Symmetry dovrebbe essere Axis. Per risolvere questo 
errore, successivamente verrà modificato questo parametro nelle condizioni al contorno. 

Nella sezione: 

• Models → Energy  

attivare il flag su “Energy Equation” in modo tale che il programma tenga in considerazione 
anche l’equazione dell’energia nella risoluzione del sistema. Dopo aver attivato il flag, 
selezionare il pulsante OK. 

È possibile, inoltre, andare scegliere il modello di turbolenza da utilizzare (con anche la 
possibilità di inserire gli effetti della compressibilità) nella sezione:  

• Viscous. 

 

 

Successivamente, selezionare la voce nel menù laterale: 

• Materials → Fluid → Fluido preso in esame (nel nostro caso è stato utilizzato N2, ma 
Ansys è di default impostato su Air). 



Si aprirà una schermata dove vengono visualizzate le proprietà del fluido utilizzato. In questa 
schermata selezionare 

• Density → ideal-gas  
• Viscosity → Sutherland 

Una volta impostata la viscosità su Sutherland si aprirà una finestra sulle proprietà e 
selezionare il pulsante “OK”. Prima di chiudere la schermata, selezionare il pulsante 
“Change/Create” per aggiornare le modifiche e successivamente chiudere la schermata con 
il pulsante “Close”. 

 

 

Successivamente andare nella sezione “Cell Zone Conditions” presente nel menù laterale, e 
selezionare la voce “Operating Conditions…” Una volta fatto ciò, si aprirà una finestra dove 
l’utente può inserire “Operating Pressure [Pa]”. Inserire come pressione di riferimento “0” e 
successivamente selezionare il pulsante “OK”. 



 

Si prosegue con l’inserimento delle condizioni al contorno. Nel menù laterale vi è la voce 
“Boundary Conditions”. Selezionando questa voce verranno visualizzate tutte le condizioni al 
contorno discusse nei capitoli precedenti.  

 

Selezionando con il tasto destro la prima voce: 

• Inlet → Type 

Sarà possibile scegliere il tipo di condizione al contorno desiderata. In questo caso, è stata 
scelta la condizione “pressure-inlet”. 



 

Si aprirà una finestra, la quale visualizza le informazioni sul tipo di condizione al contorno 
selezionata. In riferimento alla e considerando un valore di NPR=25.25, viene inserita la 
pressione di ristagno nella sezione “Gauge Total Pressure [Pa]” e la pressione iniziale nel 
campo “Supersonic/Initial Gauge Pressure [Pa]” La temperatura di riferimento è impostata su 
T=300 [K], essa può essere cambiata selezionando la sezione “Thermal”. Una volta inseriti i 
valori, selezionare Apply. 



 

Lo stesso procedimento viene eseguito selezionando la voce Outlet, viene inserita come 
condizione al contorno “Pressure Outlet” e inserita la pressione d’uscita. Dove aver inserito la 
pressione d’uscita dell’ugello, selezionare il pulsante Apply per aggiornare le modifiche. 

 



Successivamente, selezionare dal menù laterale la voce “Symmetry” e con il tasto destro 
selezionare “symmetry”. Si aprirà una finestra e selezionare la voce 

• Type -> Axis 

 

Successivamente, selezionare dal menù laterale la voce “Wall” e con il tasto destro 
selezionare “farfield”. Si aprirà una finestra e selezionare la voce: 

• Type -> pressure-far-field 

Dopo aver selezionato “pressure-far-field”, si aprirà una schermata dove verrà indicata la 
pressione di farfield da inserire. Nel caso delle simulazioni eseguite, è stata indicata la 
pressione ambiente e un valore di Mach M=0.01 come mostrato in figura. Dopo aver inserito i 
valori, selezionare il pulsante Apply. 



 

La sezione delle condizioni al contorno è terminata. A questo punto prima di procedere con il 
calcolo, nel menù laterale selezionare la voce “Reference Values” e successivamente 
selezionare 

• Compute from → inlet 

 

 

Nella sezione “Methods” nel menù laterale, è possibile andare a selezionare il metodo di 
calcolo. In questo lavoro di tesi è stato selezionato un metodo implicito e di primo ordine 
Upwind (è consigliabile utilizzare una condizione CFL relativamente bassa e limitarsi al primo 
ordine per non far sì che ci sia un collasso del calcolo).  

La condizione CFL può essere impostata sotto la voce ‘Courant Number’ nella sezione 
‘Controls’.  



 

 

Nel menù laterale selezionare la voce 

• Monitors → Residuals 

Verrà visualizzata una schermata. Controllare che i parametri di default siano fissati come in 
figura. In questo modo si potrà tranquillamente visualizzare l ‘andamento dei residui e 
stoppare la simulazione quando si sono raggiunti i risultati desiderati.  

 

Potrebbe essere inoltre molto utile andare ad inserire una sonda in un punto del dominio. 
Nella presente trattazione, per capire quando la simulazione si trovasse a convergenza, si è 



inserita una sonda di pressione in un punto prossimo alla parete, vicino alla sezione di uscita 
dell’ugello. 

In questo modo è stato possibile capire quando non vi erano più variazioni di pressione nella 
zona di ricircolo a valle del punto di separazione.  

Per fare ciò si segue il percorso:  

• Monitors -> tasto destro su Report Files -> New 

 

Si aprirà una finestra come quella in figura.  

Seguire il percorso:  

• Rinominare il file e il file name nella parte sinistra della finestra -> New -> Surface 
Report -> Facet Average 

 



 

Si aprirà una nuova finestra nella quale si potrà scegliere la grandezza termodinamica da 
andare ad analizzare nella sezione ‘Field variable’ 

Seguire il percorso:  

• New Surface -> Point  -> definire il punto in questione 

Infine si potrà definire nella sezione ‘Create’, ogni quante iterazione visualizzare tale risultato 



 

Una volta impostato correttamente premere OK.  

Tornati alla finestra precedente spostare il report appena creato con il comando ADD. Infine 
premere OK.  

 

 



A questo punto, nel menù laterale selezioniamo la voce “Initialization” e successivamente 
selezioniamo “Hybrid Initialization” e il pulsante “Initialize” per avviare il processo.  

 

 

In questa fase, dopo che l’inizializzazione è andata a buon fine, il calcolo è pronto per essere 
avviato. Prima di procedere con il calcolo, potrebbe essere utile selezionare nel menù laterale 
la voce: 

• Graphics → Contours 

Verrà visualizzata una finestra dove sarà possibile andare a scegliere quale dato visualizzare 
durante le simulazioni. È stato preso come esempio il numero di Mach. L’utente può 
selezionare il contour più adatto mediante i menù a tendina in figura. Con il pulsante 
“Colormap Options…” sarà possibile andare a modificare i parametri di visualizzazione. Per 
confermare le modifiche, selezionare il pulsante “Save/Display”. 



 

 

Durante il calcolo, non verrà visualizzato il contour ad ogni iterazione, ma solo alla fine del 
calcolo. Per questo motivo, se si vuole visualizzare il contour ad ogni iterazione, selezionare 
dal menù laterale la voce: 

• Calculation Activities → Solution Animations 

Verrà visualizzata una finestra dove l’utente potrà scegliere di salvare il contour come 
immagine, ogni tot di iterazioni.  

In questo modo, verrà visualizzato il contour scelto durante il calcolo e dopo le simulazioni, 
sarà possibile eseguire anche un rendering di tutte le iterazioni salvate per creare un unico 
video.  

Dunque, nella voce “Record after every” inserire il numero di iterazioni scelte.  

Ad esempio, se viene scelto come valore 100, Fluent, dopo 100 iterazioni, salverà un frame 
del contour e durante il calcolo, ogni 100 iterazioni verrà visualizzato il contour. È consigliabile 
inserire un valore non molto grande così da non perdere informazioni durante le iterazioni, e 
né tanto meno un valore troppo basso poiché il processo di calcolo verrà rallentato. 
Selezionato il numero di Record, selezionare il tipo di memoria nella voce “Storage Type” . In 
questo caso l’utente può scegliere dove salvare il file.  

Successivamente selezionare il tipo di contour da visualizzare nella sezione “Animation 
Object” e infine cliccare su “OK” per confermare le modifiche. 



 

 

Dopo aver eseguito il calcolo, quindi alla fine del processo, nel menù laterale selezionare la 
voce: 

• Animations → Playback 

Verrà visualizzata una schermata dove l’utente può vedere l’animazione salvata da Fluent. Per 
visualizzare l’animazione, selezionare prima il nome della visualizzazione nella voce 
“Animation Sequences” e mediante i tasti Play è possibile vedere l’animazione. Per salvare la 
registrazione in un file video, selezionare la voce 

• Write/Record Format → Video File 

Il file verrà salvato nella cartella dove vengono salvati tutti i file del Workbench. Per eseguire il 
rendering, selezionare il pulsante “Write”.  

Il file verrà salvato in formato MPEG, successivamente è consigliato convertire il file in 
formato MP4 mediante un convertitore online.  



 

Per procedere con il calcolo, selezionare la voce “Run Calculation” dal menù laterale 

Nella voce “Number of Iterations” l’utente potrà selezionare il numero di iterazioni da far 
eseguire al programma, controllando di aver raggiunto convergenza attraverso l’utilizzo di 
sonde e verificando che il valore dei residui risulti costante e pari a valori sufficientemente 
piccoli (dell’ordine della precisione di macchina o al massimo 10^-3).  

Dopo aver eseguito il Calcolo, nella sezione “Contours” è possibile andare a visualizzare il 
tipo di contour desiderato dell’utente e modificare i parametri di visualizzazione. Per 
estrapolare dati ed effettuare grafici, selezionare la voce dal menù laterale:  

• Plots → XY Plot 

Verrà visualizzata una finestra dove l’utente può scegliere quale tipo di grafico (Figura LXVII) 
andare a mostrare ed eventualmente scrivere un file di coordinate XY del dato di interesse 
selezionando il flag “Write to File”. Per scrivere il file, selezionare il pulsante “Write”.  

 



Se dovessero esserci dubbi o problemi potete contattarmi all’indirizzo mail:  

iannaconelorenzo@gmail.com 

 

mailto:iannaconelorenzo@gmail.com

